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Create pdf with word 2007

How to create a letterhead in word 2007 with logo. Create table of contents in word 2007 with hyperlinks. How to create a template in word 2007 with fields.

This feature is designed to be printed as a PDF file of a page. An HTML version is also available below. To produce accessible PDF files for the Web, the following requirements must be met: The file must meet accessibility patterns by providing alternate text for images, appropriate titles, appropriate link text, etc. The file must be exported correctly.
If a file is created printing for PDF, it will not be marked correctly. Office 2007 users must have Acrobat or Microsoft PDF add-in installed. Office 2010 users can create natively labeled PDF files or Adobe add-in. Note that the following instructions can also be used to convert PowerPoint files to PDF. Word 2007 Adobe ADOBE ADOBE ADD-IN, also
called PDF Maker, is the best choice to create high-quality marked PDF files. To export a PDF, click the Office button, hover over Save As and select Adobe PDF (or use the Alt + F, F, A shortcut. Or you can select Create Acrobat Ribbon PDF. A dialog box will appear. The program must create a PDF file marked by deform. Case contrary, select Adobe
PDF Conversion Options and select the option to create accessible PDF file (checked). Microsoft Add-in Word 2007 offers free rescue such as PDF add-in that allows you to create marked PDF files without installing acrobat. This is available at . Click the Office button, hover over Save As and select Adobe PDF (or use the Alt + F, F, P shortcut). Before
saving, select Options and verify that the tag options for the document structure for accessibility is selected. Word 2010 Adobe Add-in Please note that Acrobat Add-in is available only for users who have Acrobat X installed and have the 32-bit version of Office 2010. To export a PDF, select Create ACROBAT RIBBON PDF. Or you can select File> Save
as Adobe PDF. A dialog box will appear. The program must create a PDF file marked by deform. If you do not, select Preferences from Acrobat Tape and make sure that you enable accessibility and reflux with the labeled Adobe PDF is selected. Save PDF natively labeled PDF files can still be created without installing acrobat. Select File> Save As. In
saving as type, select PDF. Before saving, select Options and verify that the tag options for the document structure for accessibility is selected. Enabled by a fund subsidization for the improvement of secondary (FIPSE) education, US Education Department. No implicit official endorsement. I'm creating Word 2007 add-in using Visual Studio 2010. I've
searched a lot, but I'm confused now. Can anyone guide me down consultations? 1) Can we develop Word 2007 supplement using Visual Studio 2010? 2) Can we develop Word 2007 Addin only on Machine with Office 2007? 3) Will we need HKLM registry entries? A, © 1996-2014, Amazon.com, Inc. or your affiliates Every word designing you Createa If
it is a personal card, a TV series script, or a thesis in MicrobiologyA ¢ Getting the same manner. You start by creating a document, and you end up saving your work. It looks simple, but to manage your Word documents effectively, you need to know these principles and besides. This chapter shows all the different ways to create a new word
documentation how to get from an existing document or add text to a model predesigned and how to choose the best for your project.youA ¢ special will also learn to work faster and smarter, changing your vision from your document. If you want, you can use Wordan, s highlights when youans ¢ re brainstorming, and then switch to print via when
youu ¢ re ready for printed copy. Chapter You are installed and working with these fundamental tools so you can focus on the important stuffa your Words.If Youa € used Word before, so you will probably be familiar with opening and saving documents. Still, you may want to skim this chapter to catch up on the differences between this version of
Word and the ghosts of the past word. Youan 1l ¢ understand some of the great changes just examining the For more details, check the gray boxes and notes and tips - like this! The first time you start the word aft to the £ instalaA§A, the program asks you to confirm your name and initials. This on the £ o A © the nefarious plan of Microsoft to connect
you: Word uses this My Information to identify documents that you create and modify. Word uses his initials to mark their ediA§Apes when you review and add comments to Word documents that other people send to you (the SeASA £ 16.3) .VocA2 has three main ways to fire ATA © Word, so use the mA © all that you find it rAjpida: Start menu. The
button £ Start in the lower left corner of the screen provides access to all the programs on your PC A ¢ 4,— "incluAdo. To comeAS§ar the word, choose Start & 'All Programs &' & Microsoft Office 'Microsoft Office Word. lanA§amento of Fast toolbar. the toolbar startup £ rAjpida in the bottom of the screen (just to the right of the Start menu) A © one
A3timo place to start programs that you use with frequA2ncia. Microsoft assumes that modestly you'll be using the very word, the £ Enta usually installs the word Acone on the toolbar of the startup £ rAjpida. to comeASar to use Word, simply click on the icon W, and voila When you do the £ sees the lanA§amento of Fast toolbar, how to display it here:
in the bar at the bottom of the screen, click the button £ right click an empty spot. in the menu that appears, choose Toolbars "LanA§amento Fast. When you finish, the Acones for some of its programs appear in the lower bar. A single click triggers the program. Opening a Word document. Once youA ¢ create some Word documents, this mA © whole
A © Fast most of all, since you do not have to start Word as a separate step. Simply open an existing Word document and the word starts. Try comeAS§ar the comeASar - My Recent Documents, and then the list of files, choose a Word document. You Tamba © m can double-click on the icon of the document on the desktop or wherever it lives in your
PC.Se you need to become familiar with the Start menu, the startup toolbar £ rAjpida and the other Windows features, and then pick up a copy of Windows XP: the missing manual, second ediA§A the £ or Windows Vista: the missing manual. Enta £ o, what happens when you have the word engine running? If you A © one RecA © m-come, you
probably estAj just looking curiously. Whether you are familiar with previous versions of the word, PorA © m, you may be making a double socket (Figure 1-1). In Word 2007, Microsoft has combined all the old menus and toolbars in a new feature called Ribbon. Click one of the tabs above the Using Option range and sees the correct buttons command
change below. The tape commands the sA £ arranged in groups, with each group name listed at the bottom. (See Figure 1-1 For details on Using Option range.) When you start Word without opening an existing document, the program provides a void to work. Whether you are eager to put words to the page, enter the £ Enta. Sooner or later, however,
you will want comeAS§ar another new document. The word Gives you three ways to fazA?2 it: Figure 1-1. When You start Word 2007 for the first time may seem a little heavy. The tape takes up more RealEstate than the menus and toolbars of old. This can mudanA§a nA £ import it if you have a good monitor. But if you want to recover part of this space,
you can hide the range opA§Apes by double-clicking on the active tab. Later, when you need to see the tape commands, just click on a tab. Creating a new blank document. When you are preparing a single document, such as a two test pages, a note to the babAj, or a statement of imprensaA ¢ & — "a simple page without A © adorned good. Or when
you estA; Brainstorming and you are not sure what you want the final document to be, you probably want to start with a blank burning or use one of the word models (more about it at a time) to provide structure for your text . Creating a document from an existing document. For letters, curricula and other documents that require more format, why
reinvent the wheel? You can save time using an existing document as a starting point (Section 1.2.2). When you have a letter format you like, you will use it more and more by editing the Content. Creating a document of a model (Section 1.2.3). Use a template when you need a professional project for a complex document, such as a newsletter, a
contract, or minutes of the meeting. Models are very similar to forms ¢ Margins, formatting and graphics are already in place. All you do is fill your Text.Microsoft provides an incomprehensible number of templates with Word, but theya € ¢ re is not the only source. You can find more loads on the internet as described in section 5.2.1. Your employer
can still provide official models for the company documents.To start your document in any of the above ways, click the Windows logo in the upper left corner of the screen. ThatA ¢ s 2007A office S New Office button. Click on it, and a drop-down menu opens, revealing commands to create, open, and save documents. Then to these commands, you will
see a list of Word documents. This list includes documents that are open, as well as those you love recently opened.The book is also where you are going to print and send e-mail your documents (figure 1-2) .Figure , 1-2.a, the most expressed phrase frequently by experienced Word fans the first time to start Word 2007 is an OK, where ¢ My Menu
File? Ese Never fear, the equivalent of the file menu is still there ¢ s just camouflaged a bit. By clicking the Office button (the one that looks like a Windows logo) reveals the commands you use to create, open and save Word documents. Let's say you want a new blank document, just like the only word shows when you start the program. No problem
here are the steps: Choose Office Button NEW.The New Double Document appears box. In the upper left corner of the great one to create a new word panel documents, click on a blank documentation (figure 1-3). The new document box features a seemingly interminable buttop of options, but don ¢ t ¢ Nico. The option documents blank oms is on the
left side of the first line. At the bottom of the new dialog document box, click Create.The disappears from the dialog box, and youh-re looking at the blank page of a new word document.better ate. Figure, 1-3.A, open the New Document box (Office button a new, or Alt + F, N), and Word offers you several ways to create a new document. Click on a
blank document to open an empty document, similar to Word shows when you start the program. Or you can click on a new one from existing ¢ to open a document that you created earlier under a new blank name. Word document is like a spouse of clay report. With some work, you can mold it to become just about anything. Often, however, you can
save time, opening an existing document that is similar to what you want to create. Imagine that you write the minutes of the monthly meetings of the Chief Executive Officera ¢ Surfing Association (CEOSA). When it is time to write the minutes of June, Ita is much faster to open the minutes as of May. You keep the cliche text and all formatting, but
you exclude specific text that are the previous month. Now all you have to do is type the text for June and save the document with a new name: extension junminutes.docx.the .docx at the end of the file name is the word 2007a s new version of the .doc. The three letter switch for four file extensions indicates a change in the way Word stores
documents. (If you need to share documents with people who use earlier versions of Word, choose the book office from a save as a Word 97-2003 document when you save the file. See the frame in the 1.2.3 For more details.) Word Gives you a new option of creation of existing documents ¢ To satisfy your desire to pass Time to navigate and less time
written minutes from the meeting. Here-it is how to create a new document from an existing document: Choose a new Office button (Alt + F, N) to open the New Document window. Then click on a new one from Existing ¢ | A ¢ (which is just below the blank documentation). These three points at the end of the Tasting tell you that there is another box
of dialogue to come. And for sure, when you click on A 4 € ™ 4 € ceOn existing ... & & €, opens another box, appropriately entitled New of the existing document (Figure 1-4). This box looks and works - as a standard default file box. It allows you to navigate to a specific folder and open a file. On your computer, find the existing document you are using
for a template. You can use the left bar to change the folder display. Word starts you in your folder my documents, but you can switch to your work area or your computer icon by clicking on the icons on the left. Double-click on folder icons in the large window to open them and see their content. Click to select the file, and then click Create New (in
the lower right corner). (Alternatively, simply double-click the file icon to open it. This trick runs on all open file boxes.) Instead of the usual open button at the bottom of the box, the button on the new box. Existing document is read Create Novo a € "Your track that this box behaves differently from an important respect: Instead of opening an existing
file, you are doing a copy of an existing file. Once open , the file name is something like document2.docx instead of the original name. That way, when you save the file, you do not overwrite the original document. (Still, it's best to save it with a new one. Descriptive name immediately.) Figure 1-4. Use the new from the existing document box to find an
existing word document that you would like to open as a template for your new document. When you click Create new at the bottom right, the Word opens a new copy of the document, leaving the original intocad O. You can modify the copy to the content of your heart and save it under a different file name. Open file boxes, such as new from the
existing document, allow you to make much more than just find files. In fact, they allow you to do almost anything you can do in Windows Explorer. Using keyboard shortcuts, you can cut (Ctrl + X), Capia (Ctrl + C) and paste (Ctrl + V) files. A right click displays a shortcut menu with even more commands, allowing you to rename files, see the
properties dialog boxes and more. You can even drag and drop to move files and folders. She is creating minutes of gathering for the first time. You do not have an existing document to give you a leg, but you want to end up with beautiful minutes and formatted correctly. The word is at your service - with models. Microsoft provides tens in dozens of
properties for everything, from newsletters for postcards. Remember all things occupied in the new document box in figure 1-3? About 90% of the items there are models. In the previous example, where you use an existing document to create the minutes of the Meeting for the Superfecture Association of the Chief Executive Officer (CEOSA), every
month you open the minutes of the previous month. You exclude the information that belong to the previous month and insert the minutes of the current month. A model works virtually the same way, except that is a genetic document, designed to be adaptable to many different situations. You just opened it and add your text. The structure,
formatting, graphics, colors, and other doodads are already in force. The subject of word models is a long, especially when it comes to creating your own, then there is the entire chapter dedicated to this topic - 20.Hear chapter How to get some help from one of Microsoft models to accompany Minutes: Choose the Office button a € (Alt + F, n) to open
the new document window. On the left of the new document box is a list of template categories. The top entry in this list is installed models The word installed on your computer. You could use any of them, but you also have a world of choice waiting for you online. On your site, Microsoft offers hundreds of templates for all types of documents, and
you can access them from the new document box. If you have a quick internet connection, then it's just as And easy to use an online template as it is using the stored on your computer. In fact, you will use an online template for this example. If you can not connect to the internet right now, just choose one of the installed models. Click Create, and
then jump to step 4. Move the list of categories of the template for the Microsoft Office Online Header. Under this title, select Minutes. In the center panel, you will see all different types of minutes models, from minutes of PTA to minutes of annual shareholder meeting (Figure 1-5). When you click the icon of a template, a view appears in the right
pane.figure 1-5. The new document box lists Premately Models that live in Microsoft Office Online in categories such as schedules, brochures, calendars and minutes. Below the thumbnail you see an estimate of how long it takes to download the Microsoft Office Online website template. A ratings, from 0 to 5 stars, informs you what other people think
of the model (the classification system is like Amazon.com). When you finish pouring the various styles, click on the minute minute icon. (After all, CEOSA is a very formal organization.) Then click Download.Word Downloads and opens the document. Start writing minutes for CEO surfers. To follow the model structure, replace all words in square
brackets ([]1) with relevant text for CEOSA. If you prefer not to download the formal model of minutes of the time you use, then you can save the file on your computer as a word model. The steps to save files are just around the corner in the 1.5 section. If you have mastered the creation of an existing document and creating a document of a template,
you will find that the opening of an existing document is a fitting. The steps are almost idless. Choose the Office button a € 'Open (Alt + F, O). In the open window (Figure 1-6), navigate to the folder and file you want to open. The open window is started by displaying your folder my documents as it is where the word suggests that you save your files.
When your document is in a more exact location, click on the icon my computer, and then navigate to the appropriate folder from there. When you open a document, you recently used, you can see your name in the office button & € "Recent documents menu. If so, just click to open it without a trip to the dialog box open. With the selected file, click
Open in the lower right corner. The open box disappears and your document is open in Word. You are all ready to start working. Just remember, when you save this document (Alt + F, S or Ctrl + S), you write about the previous file. Essentially, you create a new, improved and single copy of the file you just opened. If you do not want to write about
the existing document, use the save command. (ALT + F, A) and enter a new name in the text box. Figure 1-6. , = = "Look in the top. The tale of files of two cities. The docx is selected, as you can see In the "Name box" File in the window. By clicking open, Mr. Dickens is ready to go to work. Opening a file in the word does not mean that you are
limited to documents created in Word. You can choose documents created in other programs from the files from the type drop-down menu at the bottom of the Open Dialog box. Word shows this type of document in the main part of the window. You can open Outlook (.msg) messages, web pages (.htm or .html) or files from other text processors (.rtf,
.mcw, .wps). Now that you know a handful of ways to create and open word documents, it's time to take a look at the establishment. You Thinking that a document from a document is just looking at it and doing your job. It's amazing, so, how to change your page vision can help you work faster and smarter. When you are working with a very long
document, you can switch to outlining the visualization and and Only the headlines of your document without the text of the paragraph. In the contour vision, you get a better sensation by the manuscript as a whole. Likewise, when you are working on a document that is headed for the web, it makes sense to see the page as it will appear in a browser.
Other times, you may want to have two open documents on your screen at the same time (or each of the two monitors, you are lucky dog), to facilitate cutting and paste text from one to the other. The key to working with the different display options of the word is to combine with the work vision in hand. After accustoming to changing sight, you will
find many reasons to change your point of view. Find the tools you need in the View tab (Figure 1-7). To get there, click the View tab (Alt + W) in the option range (near the top of the word window). The tab divides the display commands in four groups: document views. These commands alter the great figure. For the most part, using these when you
want to display a document in a radically different way: two page side by side, highlight view, web layout display, and so on. Appear to hide. Show / Hide Commands display and hide Word tools like Rés and GridLines. These tools do not show when you print your document; They are just visual helps that help you when you are working on the word.
Expandment. As you can guess, zoom tools allow you to choose between a close-up and a long photo of your document. Keeping close to your word to read and helps avoid faxing. But the zoom does with the zoom makes roll faster and helps you keep an eye on the big picture. In addition to the zoom tools on the tape, atosis zoom tools are available in
the lower right corner of the window. Check the + (enlarge) and "zoom out) and the slider between them. See the 1.4.3 section for details on how to use them. Window. In the group of windows, you will find ways creative to organize document windows on your screen - as divided views from a single document or side views of two different documents.
All commands on the guide display four groups are covered in the following pages. This section Provides the short stroke to view your Word documents. For more details and options to customize your Word environment, refer to the 17.Figure 1-7 chapter. The View tab is your Visualization Control Center. of documents. Look closely, and you are
divided into four groups with names at the bottom of the option range: Document views, display / hide, zoom and window. To apply A view command, just click the or label.Word button provides five basic document views. To select a display, go to the View tab (Alt + W) and choose one of the document displays on the left side of the option range
(Figure 1-8). You have another great option to change from one vision to another that is always available in the lower right corner of the word window. Click on one of the five small buttons on the left of the slider to skip between printing layout, full screen reading, web layout, sketch and draft viewing. Each view has a special purpose, and you can
modify them even more using the other commands on the View tab. Figure 1-8. On the left side of the Display tab, you find the five Basic Document Points: Print Layout, complete screen reading, web layout, sketch and draft. You can edit your document in any of the displays, although they come with different tools for different purposes. For example,
highlight view provides a menu that allows you to show or hide headers in different contour levels.Changing your vision in nothing affects the document ItsselfA ¢ youA ¢ is just looking at the same document from a perspective Printing Layout (Alt + W, P). The most commonly used view in Word, printing layout is the one that you see when you start
the program or create a new blank document. In this vision, the page that you see on your computer screen looks a lot when you print. This vision is useful for letters, relatives and most documents directed to the printer. Full screen reading (Alt + W, F). If you would like to get rid of the Ribbons, and all the rest of the text processing paraphernal,
then use full screen reading screen. As the name indicates, this VIEWA was mainly designed for reading documents. It includes options that you donate to find in other views, as a command that temporarily decreases or increases the size of the text. In the upper right corner you see some document review tools (such as a text marker and an insertion
comment command), but when you want to change or edit the document, you must first use the oppon Display Access to Leave the digit command. For more details on using Word for review and tests, see chapter 16. Web layout (Alt + W, L). This view shows the document as if it were a single web page loaded in a browser. You do not see any pages in
this view. Along with your text, you see all photos or video you-¢ already placed in the documentation as a web page. Section 13.2 has more details on the creation of web pages with Word. Contour (Alt + W, L). For many writers, a sketch is the first step in the creation of a manuscript. Once theyan ¢ we created a chapter and title structure, they dive
and fill out the document with the text. If you like to work this way, then LL Vista love outline. Italy Italy Skip To Through Front From Highlights View and Print Schema View or Vista Design, so you can jump for back between a macro and a micro vision of your is Pica. (For more details on Wordan use, s from the sketch, see section 8.1.) Project (Alt +
W, V). In-nonsense, roll-up-your-sleeves View your work (Figure 1-9). You see more format as it appears on the printed page except for heads and footers. Pages of page are indicated by a fine dotted line. At this point of view, ITA is as if the document is in a single roll of paper that runs through the computer screen. This Viewe is a good choice for
longer documents and those times when you want to focus on the words without distracting pages of page and other niceties.Word formatting you give you some visual aids that make it easy to work with your documents. Tools like rulers and grill lines do not appear when you print the document, but they help align the elements of the page. Use the
rail for the margins of the set page and create guides for your documents. Select Boxes On the View tab let you show or hide tools, but some sand tools available at all points of view, so the grayish. You cana € ¢ t, for example, racks from the display page in rows or full screen reading views.Use the boxes on the show / hide guide group display (figure
1-10) to turn these tools On and off: RA © Gua. Use the rail to adjust the margins, set guides, and position items on your page. For details on the text and paraphrames formatting, see the chapter 4. Grid lines. When you click on the grid lines box, it looks like you created your document on a portion of millimeter paper. This isnamed very useful effect
for an all-text document, but it sure comes in handy if you are trying to align photos in a page.figurean, 1-9.3, in project Vista, you see more text and format Paraphices, but heads, rods If other disturbing page formatting features are hidden. Your text appears as a roll of container paper, with the hidden margins. Painting breaks appear as dotted
lines. Message bar. The message bar resides directly under the tape, and it is where you see alerts about the behavior of a document s. For example, when a document is to try to run a macro and your Word prohibit macros settings, an alert will be displayed in the message bar. Click the Selection box to display or The message bar. Map document. If
you work with long documents, youh-¢ 11 as the document map. This useful tool appears to the left of the text (you can see it in figure 1-10), showing headers documents in several levels. Click on + Anda, small buttons next to a title to expand or reduce the outline. Click on a title, and you jump to this location in the document. Miniatures. Select the
thumbnail option, and you see small pages of pages that documents it in bar to the left. Click a thumbnail to go for that page. In general, thumbnails are more useful for shorter documents and pages that are visually distinguished. For longer documents, youha ¢ will find the map of the easiest document to use for navigation. When you are working,
you always find that you sometimes keep pages of weapon s length to get a complete vision and then at other times, you stick your nose near the page to examine the Details? Wordan Zoom Options (Figure 1-11) allow you to do it same with your screenan ¢ but without looking almost so silly.figurean, 1-10.3, use the show / hide group On the View tab
to view or hide Word tools. The rail will give you a quick and easy way of joint guides and margins. The document map is particularly useful when you work with longer documents because it displays tutulos on the bar on the left side of the screen. In the left pane, you can see that Mr. Dickens wrote more than its chapters. Figurean group, 1-11. The
option zoom allows you to view the document closely or forth. ¢ The large magnifying glass opens the zoom dialog box with more controls for fine-tuning the zoom level. For fast changes, click on one of the three buttons on the right: a page, two pages, or pagina width.even although the text seems to get bigger and smaller when you increase the
zoom, youan ¢ Really not change the document anyway. Zoom is similar to bringing a pace closer so you can read the lyrics. If you really want to change the size of the font, use the formatting options on the Home tab (ALT + H, FS). In the View tab, click on the large magnifying glass to open the zoom dialog box (Figure 1-12). Depending on your
current document display (see section 1.4), you can adjust the display by percentage or in page relation and text (more on this in just a moment). The options to change a little depending on which document to see you? The page pages do not actually apply to web layouts, so asA ¢ re gray and inactive if youA ¢ re in the web layout box view.figurean, 1-
12.3, the dialog zoom Allows you to choose from a variety of viewing. Just click on one of the option buttons and click OK. The monitor sample and text at the bottom of the zoom box provide visual clues as you change the settings. In the box are upper left corner, you will find controls for zoom in and out of your document per percentage. The vision
varies according to the computer screen and configurations, but in general, 100% is a respectable, half-the-road of your document. The higher the percentage, the more enlarged you are, and the higher the vice-all looksmen with a percentantage.The three smaller radio buttons (200%, 100% and 75%) give you fast access Some standard
configurations. For in percentages between (like 145%), enter a number in the box below the buttons, or use the top down arrows to change the value. For a quick zoom in and out way without opening a dialog box, use the zoom slider (Figure 1-13) in the lower right corner of the window. Drag the slider to the right to zoom in on your document, and
drag it to the left to zoom out. The percentage changes as you slider drag.figurean, 1-13.3, the zoom at the bottom of the document window gives you a quick and easy way to change your perspective. Drag the slider to the right to zoom in on your document, and drag it to the left to zoom out. To the left of the slider are five display buttons: Printing
Layout, Full Screen Reading, Web Layout, Contour, and Draft (Section 1.4.2). Since the first button is selected, this document is in Print Layout view.Not everyone ¢ s one person number. (Thata € ™ s especially true of writers.) You may prefer zoom without worrying about percentage numbers. The zoom dialog box (on the View tab, click the
magnifying glass) Give it four radio buttons with plain-English zoom settings: page width. Click on this button and page is resized to fill the screen from side to side. ItA ¢ is the most fastest way to enlarge for a text size that most people find comfortable comfortable reading. (You may have to roll, but to read the page from top to bottom.) Width of the
text. This button enlarges even further because it ignores the margins of your page. Use this if you have a high resolution monitor (or you will miss your reading glasses). Whole page. When you want to see a whole page from top to bottom and from left to right, click on this button. Italy is great to get a general vision of how the headings and
paraphages look at the page. Many pages. This point of view is the equivalent to spread your document on the ground, and then see it from the top of a ladder. You can use it to see how you are close to ending this paper of five pages, or to inspect the layout of a multi-page Newsletter.When YouA ¢ ¢ re-enlarged for all or in a lot of pages, Fingers on
the keyboard. You can still make changes in your text at these points of view, even if you t cana see what you ¢ re ding.The offers radio ribbon buttons for three popular pages page. (You can see them back in Figure 1-11, to the right toola s zoom.) TheyA ¢ Ripe a quick and dirty way to change the number of pages you see on the screen without
messing with. Zoom controls. One page. This visualization shows the entire page in the Wordan document window, s. If the screen is large enough, you can read and edit text in this view. Two pages. At this point of view, you see two pages side by side. This VIEW is useful when you will work with documents that have two pages such as leaflets.
Pagina width. This button does exactly the same thing as the page width button in the Zoom dialog box (Section 1.4.3). It is more readable than the options of a page and two pages, because the page fills the end-to-end screen, causing the text to look larger. Back when dinosaurs lived on Earth and people wore writing machines (or very early text
processors), you can work in just one document from each time the right path in front of you. Although Word 2007 has more options for visualization of several documents and several windows than ever, some people forget to use them. Big mistake. If you ever find yourself comparing two documents or voids extensively from some other text, then
having two or more visible documents on the screen can bend or triple your Speed.The commands work to manage several documents, view Aches and windows are on Taba See group S Window (Figure 1-14) .Figure, 1-14.4, in the window group, the three commands in the LEFTA New window, organize everything, and split it to open it and visualize
your multiple work points. The commands in the Middle ¢ Side Side by Side, Synchronous Scrolling, and Readjust Window POSITION OF SAO SAO ALSEFORDS When analyzing and comparing documents. The big Windows button switch allows you to hop from one document to another. New window (Alt + W, N). When you are working on a long
document, you sometimes want to see two different parts of the document at the same time as if they were two different documents. You may want to keep referring to what you said in the Introduction, While You, you're working on chapter 5. Or maybe you want to keep an open source vision during edition in Draft view. Thata S where the new
window command enters. When you click on this button (or hit this key combination), you (I have the document opened in two windows that can be moved independently. Make a change to a window, and it immediately appears in the other. All (ALT + W, A). Great now youan ¢ I have documents to open in two or more windows, but it takes a pile of a
lot of hovering the mouse around and resizing window to get them aligned on your screen at the same time. Click Organize Everything and, as magic, the open Word document windows are sharing the screen, making it more work in one and then the other. Word has an egalitarian approach to the real estate screen, giving all windows an equal
amount of property (Figure 1-15). Split (Alt + W, S). The split button divides a single window so you can see two different parts of the same documentation particularly useful if you ¢ re copying text text a part of one document to another. The other advantage of the Split command is that it makes you more space to work than use organizing
everything for multiple windows because duplicate ribbon donor, rail, and other Word tools (figure 1-16). Figure, 1-15. There is a disadvantage of the 2007A tape Script: it occupies more space on the screen of your menu computer or even the older button bars. When you open a pair of windows, youa € ™ s is left with much space to do your job,
especially when youans ¢ re working on an ultra-portable laptop or a computer with a small screen. You can double-click on the active tab to hide the tape, but in most cases, you will better out working with a split screen, as shown in Figure 1-16.Figure, 1-16.a, when youu ¢ re seeing two different parts of a single document, use the Split command; It
leaves you more space for the work of two separate windows, as shown in Figure 1-15. Each section of the split window has a scroll bar so that it can independently control different parts of your document. If you want to tune your division, just drag the middle bar exactly where you want. When you are done, click Remove Division to return to a single
screen view. One common reason to want to see two documents or more on your screen at the same time is so you can make comparisions line per line. Imagine that you have two Word documents that are almost ideas, but you have to find the points where there are differenties. A great way to make these differences jump out is to put the two
versions on your side of your side screen and run away. As you roll, you can see the differences in paragraph lengths and lines lengths. Here are the commands to help you with the process: see side by side (Alt + W, B). Click the side view by the Side command and organize the word two windows vertically side by side. As you work with Side By-side
documents, you can rearrange the windows on your screen by dragging the top of the window frame. You can resize the windows, pointing to any frame edge. When you see a double arrow, just drag to resize the window. Surrono scrolling (described below) is automatically turned on. SonCrono Scrolling (Alt + W, Y). The Synchronous Scrolling
feature maintains several document windows in the locking step. When you scroll a window, the other windows automatically scroll as well. Using the same button or key, you can switch synchronous scrolling in and out as you work with your documents. Reset Windows Position (Alt + W, T). If you have moved or resized the document windows, as
described above on display side by side, then you can click on this button to reset the display mode to the Share the Screen equal. Since the first days of the personal computation, the word of order has been a save early, save often.a € There are nothing more frustrating than working half of the day and then having to evaporate great American novel
in is Digital, because your power goes out. So here are some tips to protect your human-made and natural disaster work: name and save the document soon after you first create it. You will see the steps to make it later in this section.Get the habit of making a quick save with alt + f, s (think file save) when you stop to think or get up to go to the
Kitchen for a snack. (Note for Veterans: Ctrl + S still works for a fast save too.) If you will get your computer for an extended period of time, save and close the document with Alt + F, C (I think I think. Close file). ItA ¢ is the way Microsoft to give you several ways to do almost everything. If that are because the programmers CompanyA ¢ s believe in
giving you many options, or because t cane do the Minds about the best way to do something is a better question to leave for the philosophers. But the point is, you have a choice. You do not have to memorize all the keys, button and command. Especially with the economy, the important thing is to find a way you like and stay with it. Here is a list of
some ways you can save the You are working on: Ctrl + s. If you are an old hand in the word, this keyboard shortcut can be burned in your brain. It still works with word and other office programs. This command quickly saves the document and allows you to go back to work. Alt + F, S. This keyboard shortcut does exactly the same thing as Ctrl + S.
Contrary to Ctrl + S, you get visual reminders of which keys you press when you press the ALT key. See the box above. Office Button - Save. If you do not want to use keyboard shortcuts, you can mouse to the same place using menus. As the options above, this command saves your file with your current name. Book the office a € 'Save as. The option
save how allows you to save your file with a new name (Figure 1-17). When you use this command, create a new document with a new name that includes any changes you do. (The individual steps are described in the next Section.) Figure 1-17. Use the Office button & € 'Save as to save your file with a new name or in a different file format. In this
example, the two-citized word file tale is being saved as an HTML type file - a format used for web pages. Bookmark a € 'Close. When you close a document, word checks to see if you did any changes to the file. When you made changes, the word always asks if you would like to save the document (figure 1-18) .figure 1-18. When you see this message
box, you have three options: Yes saves your document before closing it; Do not close your document without saving it; Cancel the leaves your open document without saving it.when you save a new document or save a document with a new name (save as), youan ¢ I have three things to consider: a file name, a file location and a format of file. Figure 1-
19. To open a backup file, choose all files (*. *) From the "Foots of type" drop-down menu at the bottom of the Open Dialog box. Look for a file that starts with the words A ¢ & € t f backup. Double-click to open the file. Here are the steps to save a file, complete with a new name: Choose the Office button & € 'Save as Open Save as Box. You use the
Save the Save as when you are saving a file with a new name. Word also displays the save box as the first time you saves a new document. Use the "ESA IN" drop-down list or double-click to open folders in the window to locate a location to store your file. The buttons in the upper right corner can also help you navigate. See the details in Figure 1-21.
The word does not care where you save your files, so you can choose your work area or any folder on your computer. Figure 1-20. When you can not open a file with a normal open command, click the arrow to the right of the Open button and choose Open and Repair from the drop-down menu. Some parts of your file can still be damaged, but you can
usually recover most of your work. The more files you saves your computer, the more useful one to have a logo folder and a file system. If you keep hundreds of Word documents, you may want to have different folders calls: letters, memos, relatives and newsletters. At the bottom of the save-as dialog box, type a name in the File Name box. Accepts
long names, then you do not need to save money. Use a descriptive name that will help you identify the file two weeks or two from now on. A good name saves long-term time. Use ~ a € f Save as type in the box to choose a file type. In most cases you do not need to change the file type. The word automatically selects .docx or .docm, depending on the
context of your file, but Word can save files in more than one duct different formats. If you are sharing the file with someone who uses an older version of Word, choose the Word 97-2003 document to save the document in .doc format. If you are sharing with someone who uses a Mac or Linux computer, you may want to use the most universal rich text
format (.rtf). If you want to use your document as a template in the future, then choose Word template (.dotx). Use the Macro-enabled format (.dotm) if it is Created any macros (Section 19.2). Without you, sharing your file with someone using an older version of Word or a different operating system or doing a template, remove the new .docx pattern
(for normal word files) and .docm (for files running macros). See the box in the 1.2.3 section for a complete summary. Click Save.Word does the rest. Everything you need to do is remember where you saved your work. Figure 1-21. The dialog box saves as all the controls you need to navigate to any location on your computer - including five nice
buttons in the upper right corner. From left to right: The left arrow button steps back to your previous locations (as well as the button back into a web browser). The up arrow takes you to the folder that includes the one you are now. The X button excludes folders and files - be careful about it. Click the folder with the star in the corner to create a new
folder. Get Word 2007: The Missing Manual now with Reilly Online Learning. Reilly's members experience live online training, besides books, video and digital contents of 2002 publishers. publishers.
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